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Publish digital flash shopping brochure with page flipping effect
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About Flash Shopping Brochure

Flash Shopping Brochure is an amazing page-turn
converter which can publish virtual shopping
catalog with 3D page turning effect. With this
powerful program, you can edit the flipping pages
with multimedia and other functions, which can
help you to turn the PDF catalogs into interactive
sales tools. You can insert dynamic price for the
goods; add page link, web link, e-mail link to the
electronic flip catalogue; add buttons to call
JavaScript function, open flash window or photo

slideshow.

Note: This product is distributed on a "Try before-you-buy"
basis. All features described in this documentation are
enabled. The registered version doesn't insert a watermark in

your generated page-flipping brochures.
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Product Features

10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

Easy steps to import and output:

Convert PDF to 3D virtual digital brochure with page flipping effect;

Select PDF from the source files;

Open the PDF file before importing to make sure if it's the one you want to convert;
Choose to import all pages or custom range pages;

Choose quick import mode to import 10 pages only for initial preview;

Choose one from the 5 types of page quality for different book size to output;

Add and edit watermarks, logos, images, dynamic date/time from pre-designed source or
from your own resources;

Enable or disable to import bookmark to the flash brochure;

Enable or disable to import internal link (page link) and external links (web link, e-mail
link...);

Enable or disable search function to search the imported text content or not;

Detect wide page to view landscape pages spread on two portrait pages area.

Support batch convert multiple PDF files to multiple or a flipping book at the same time;
Choose output format to convert PDF to flash brochure;

Define output folder path and file name;

Advanced settings to define title, keywords and description for the online HTML(for HTML,
Zip and Exe format only);

Exe advanced settings allow you to change icon picture(ICO file only) and define Exe window

size;
3 kinds of render engines for the conversion to avoid distortion;
Click "Convert" button to publish flash brochure in your defined format;

Automate the conversion in command line mode.

Copyright 2010 by Flash-eBrochure-Maker.com
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10.

11.

Powerful application of "Edit Shopping Cart":

Add text button and define content such as "Buy Now";
Insert dynamic price to the flash pages;
Add buttons from resources or import new resources;

Add links to open a link, call JavaScript function, open flash window and photo slideshow,

etc;

Embed flipping pages with video, audio, flash, YouTube video;

Insert images (album) to create pop up photo slideshow;

Add button to call new actions (go to the appointed page, open a link, play audio...);
Add printable area as coupon for readers;

Copy and paste selected objects (link, video, audio, image...);

Delete the unwanted objects;

Zoom in and zoom out while editing the flash pages.

Flexible output formats:

Publish HTML online brochure to make it worldwide reachable via Internet;

Publish flipbook in Exe and Zip format to store or send to your readers;

Mac App format enables you to view the flash book on Mac devices;

Mobile version can run on portable devices such as iPad, iPhone, Android Phones...;

Burning to CD enables you to store the flip brochure in CD/DVD and play on computers.

Customize your flash brochure:

Define bookmark for the flash brochure;

3 built-in templates(classical, float and spread) and various themes to decorate your online

brochures;
Choose images for outer and inner background;
Enable sound and choose your preferred sound as background music;

Save the template settings for later use;
Copyright 2010 by Flash-eBrochure-Maker.com
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6.

10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

23.

24.

25.

26.

Choose a book logo and define book title for your flash brochure;

Show or hide the toolbar or other buttons (home, full screen, help, share, social share...);
Use the Minime style to hide the toolbar;

Decide to use self or blank open window for home page and links;

Font setting for flash, bookmark, buttons, window, search results...;

Define color for background, font, buttons, icons...;

Enable or disable single page reading interface;

Define a default language for the flash brochure or use two or more kinds to make languages
switchable;

Define book proportion, margin and page shadow;

Choose to use "Right-to-left" reading(Arabic for example) or not;

Choose a hard cover for the flash shopping catalog;

Show flipping effect at the corners when the mouse moves over;

Insert page number and start page number;

Auto play setting allows it to play as soon as you open the flash flipping book;

Enable or disable thumbnail button to show or hide thumbnail;

Activate Google Analytics Integration to get real-time statistics of your readers;

Set limitations to decide if your readers could download, print or share your flash book;

Set flash security to allow your readers to view all pages, certain range pages or they have no
access to even a page of the flash brochure;

Use "Zoom" function to read the flash book;
Help button allows you to add Help image or Flash to guide the readers;

About button allows you to add and show company file and contact information.

Copyright 2010 by Flash-eBrochure-Maker.com
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Flash brochure features:

10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

23.

24.

Present the shopping brochure in 3D flip interface;

Open the flash brochure with hard cover;

Turn a page by clicking the page shadow;

Turn a page by dragging the corners;

Turn a page by sliding the mouse wheel;

Turn a page by clicking the "First/Last, Previous/Next Page" buttons;
Turn a page by using keyboard arrows;

Turn to a certain page by entering the page number;

Use thumbnail to go to the page or get content you want;
View the flash brochure in full screen;

Enable auto play to view the flash brochure;

Zoom to read every detail of the flash book clearly;
Double-click to zoom in or zoom out;

Zoom the dynamic price when mouse goes over;

Turn on/off the background music while reading the book;
Click links to go to a defined page, e-mail interface or website;
View video, flash, YouTube video, photo slideshow;

Enjoy beautiful music or recording sound;

Print out the printable area directly as coupons;

Print out the flash brochure or custom range pages;

Share the book via e-mail or social networks such as Facebook, Twitter, Digg, Reddit...;

View the flash brochure on iPad, iPhone, Android Phones or other portable devices;

Click "Help" button to view help manual;

Click "About" button to see author, company and contact information of the flash brochure.

Copyright 2010 by Flash-eBrochure-Maker.com
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Operations:

» Easy Import:

1. Launch the program via the desktop shortcut

& Import Shopping Catalog{PDF
2. Click the "Import PDF" icon 4 et it 9 B

interface;

User Document

to enter into Import PDF

. -
Import PDF - s

Source PDF Flie

Browse.. ] ’ Open it l

The Page Ranges to Import Watermark:
© All pages L4 Place a custom text or image
@ Custom range: ' e Watermark(Stamp) to the file(s)
4
Quickly import (Only import 10 pages to initial preview) Set Watermark
Page Quality
Quality And Size: [High quality large file size V]

#h High values produce better page quality but require more disk space and more time to download,

Import bookmark Import links Enable search Detect wide pages

Cimportiow ] [_gonet |

3. Click icon to choose PDF file from your computer;

4. Click [ =i ]icon to open and see if it is the file you want to convert;

5. Choose to import all pages or custom range pages;

6 CIick‘ Set Watermark ‘

watermark(s) for the flipbook;

Copyright 2010 by Flash-eBrochure-Maker.com
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= Selete Tatermark

Select one or more Watermark(s) Watermark Preview

+ g K|+ 4| S| [FEvewstle - [] Check &l

There are 5 types of watermarks for you to choose: Text Watermark, Dynamic
Datetime watermark, Image Watermark, PDF Watermark and Shape Watermark. You
can define the parameter for different watermark.

Text Watermark:

= Add Text Watermar

A: Add Text Watermar
Text Name

Name: |2

Test: [a-pdf watermark

General | Text Effect | Range | Links | DateTime

Text Properties
Fort: & Helvetica v
Sizes [24 = color: [N
Style: []Bold Oitalic [ underline
Position Inmargins |~ Marging
= [Fluse %ip) a-pdf watermark
ww Ll Top: |0 &
jm|m .‘ Left: |0 E Right: 0 =
m = m Bottom: [0 =
[IFit to margins
[T Style(2y
Metric units
units | Inches 5

Dynamic Datetime Watermark:

= Dynemic Datetime ratermar — (Dynamic Datelime watermar)

(< Dynamic Datetime watermar

General |Range | Border

Name: | B

Eormat |prink at:{mm-dd-yy} ¥
Text
Fonb(H): | Courier v

Font Size: |24 Text color: [

Fostioninmargins -~ Margins

w2 = print at:05-06-12

(| m| m| Lefts [0 s Right: [0
m = m Eottom: [0 -
w000 ¥ 0.00

Uit

Inches -

Copyright 2010 by Flash-eBrochure-Maker.com
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[¥]Fit to margins

Uit

[Inches

Fosition in margins

Image Watermark:
= Add Tmagze Watermar

4. add Image watermark
Image Hame:

General | Effect | Range | Links

|
Image Properties

Flash Shopping Brochure Utility

User Document

Margins
" il [“Juse % - <
== m gottom: 5 |4
[Eit to margins
Unit
[Inches

[l strecth to margins

v

PDF Watermark:

= Add PDY Natermar

sl PDF wWatermark

Wakermark Name

Hame: | POF Waksrmar

POF: |

General | Effect | Range
Page Range

i 4 4 Jwo
| [orgeee

@ #ll page

Propertiss

T —

bl

Position inmargins -~ Margins
" Use %

s
m = m Bottom:[o |2
Fit ko margins [ stretch ko margins
Unit
[Inches v

Shape Watermark:

= Add Shape Tatermar

&5 Add Shape Watermark

Shape Type: ‘C\rde

Position and Effect |cmnrs and Lines | Effect | Range | Link
Fropertiss

b ]

Position in margins -~ Margins
T3 Use %

b ]

v

Copyright 2010 by Flash-eBrochure-Maker.com
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7. Choose the output quality and size

| Pages Quality and Size

Quality And Size:

High rge file size
Medium quality medium file size
Low quality small file size
Lower quality smaller file size

i High values
' butrequire m

8. Enable or disable the following functions:

RIS Import bookmarks to the flipbook so that your readers can find

the contents easily;

Witmportlinks £ there are links in your PDF files, the flipbook will retain the

links;

[VIEnable search  cpack this option to enable search functionality in created
flipbook.

[/|Detect wide pages  This option can enable the PDF file to be presented in

two-page spread in output flipbook.

Import Now

9. Click icon to enter into custom setting interface.

Copyright 2010 by Flash-eBrochure-Maker.com
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> Edit Shopping Cart:

Flash Shopping Brochure is special design for online shopping catalog, and this
powerful software enables you to edit the flipping shopping catalog with

multimedia and other functions.

S -\ Edit Shopping Cart

1. Click - icon to enter shopping cart editing interface;

S Edit Page for Shopping Cart T - Tl .

ANTOEE sO0Ed FTRE BB T Q8Q

Page Editing: 1

Flash Shopping Brochure

Publish digital flash shopping brochure with page flipping effect

3

Page Count: 8

. T B .
2. Click icon to add text button, draw a link box * -—--+--- on the area you

want, and then you will see the text button properties:

Copyright 2010 by Flash-eBrochure-Maker.com
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Text Button Properties
Button Caption:

Font Color:

LIRL:

Advance Action Options

Action Infos(target: _blank)

You can define colors and alpha for mouse actions (over, down, normal actions),

adjust the size and add hint address.

. Advance Action Options
Click

icon to call new action: Go to page, open a link, call

Javascript function, open flash window, play audio and photo slideshow.

Action Options

® Move

& Cut

Please select an action type,

® Go to page & Cpen alink @ Call Javascript function

& Open Flash window 8 Play Audioc  # Photo Slidest

LIRL:

Lirk Target:

(1) Goto Page

Select "Go to page" and define which page to go, for example page 4

Copyright 2010 by Flash-eBrochure-Maker.com
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Go To Page:

, click "OK", then you can go to page 4 directly by
clicking the page link.

(2) Open alink

Choose "Open a link" action, you should add URL and

define link target as blank, self, parent or top and you will go to where you want.

Link Target:

Blank
SELF
Parent

Taop

(3) Call Javascript action

Write down Javascript function text in the box and

make sure the Javascript wrote into the index.html page, and then you can call
the Javascript function by clicking the action link.

(4) Open a flash window

Select "Open a flash window", then the "Open Window Action Properties" box
will pop up.
Open Window Action Properties

Window Type: Dpen the window to play a video
i j oy Content:
Y colect The File

Please choose the resource file

Wir Caption:

wincone Width: Window Height:

Copyright 2010 by Flash-eBrochure-Maker.com
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Window Canter Open the window to show a SWFRiFlash)

Open the window to show sorme text

Select the window type and then select the file from your computer to imput text
content directly, define window caption, width and height.
(5) Play Audio

Select an audio file and choose auto play or not;

I Select a Audio File(MP2) m

(6) Photo Slideshow

Select "Photo Slideshow", then it will pop up the below interface:

Add Images

Add images from your computer, and press "OK". And when you click the link, the

photo slideshow will pop up.

-13 -
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3. Click icon to add dynamic price to the pages

47

|
MU |
R T, |

Define hint, price unit, price, background color, URL and other parameter for the

dynamic price box as below box.
Properties

Hint
Price Unit

Frice

Background Color

LIRL:

Advance Action Options

Action Infoe(target: _blank)

4. Add pop up photos to the pages

N
Click icon to add pop up photos. See as below box:
Phaotos

URL Action

Add Images
Advance Action Options

Action Infio:

H:

a gy B
(L |

Hint:

Copyright 2010 by Flash-eBrochure-Maker.com
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Add images and define the action settings, then when you are viewing the
flipping shopping catalog, the photos will pop up.

Add button from resources

Click icon to enter into button resources box, choose buttons from the

resources. Or you can import resources from your computer.

Button Resources

Import Resources

Click icon to add links, draw a link box “----- “on the area you want, and

then you will see the link properties:

Link Properties

Action Options

Mo action.

Copyright 2010 by Flash-eBrochure-Maker.com
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1/4

7.

10.

Add movie that plays FLV

Clik to add movie that plays FLV, and you will see the movie

box.and movie properties interface as below:

Movie Properties

Select FLY Mavie

Movie: Blark

Stop Movie: When leave the page

Select FLV movie and player skin color, define play and stop action, define
interface size.

Add Image

Click to add an image, you can choose an image from your computer and

define action options as above mentioned: go to page, open a link, call javascript
function, open flash window, play audio and photo slideshow.

Add Sound

1 1
Click E to add music to the flipbook. You will see the music palyer g !
select sound from your computer and define mouse actions. When you open the

flipbook, just click “=*<" and the music will start to play.

Add SWF

Click .to add SWF to the flipping page. Just select a SWF from and then
define proportion for the SWF.

Copyright 2010 by Flash-eBrochure-Maker.com
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Swr s
Select 2 Swf

SWF: Blank

11. Add Button

P
Click . icon to add buttons to call new actions. Select an icon(SWF or image)

for the new action and select the action: go to page, open a link, call javascript
function, open flash window, play audio and photo slideshow.

Button Properties
Select an Iconi(SWF,Image)

Button: Blark

Action Options

12. Add Youtube Video

 You |
Click icon to add Youtube video. Input Video ID and parameters, define

mouse actions and proportions, and you can see the Youtube video in the
flipbook.

YouTube Video Properties

rameters:

Play Movie: when click Play button

Stop Maovie: When leave the page

W

H:

Copyright 2010 by Flash-eBrochure-Maker.com
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13. Add Printable Area

™
Click icon to add printable area as coupon.

Link Properties

Color: B e dlpha

Border Colar; Border Width:
Title:

Description:

If you want coupons in your flipbook, you can add printable area, just define color,
title, description and proportions for the coupon. And you readers can print it out
with ease.

After finishing editing the flip pages, just click "File=>Save And Exit", then all these
amazing functions will present in your filpbook.

Copyright 2010 by Flash-eBrochure-Maker.com
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> Custom Settings:

File Convert Options Help

| K tmport Shopping CatalogP0F) (3] | EdtshoppingCart | (M Apply Change 4, Convert To Flipping Book | -1 Batch Convert

|
Design Settng | Bookmrk| —— ———— = -_— — -
Templates : . % || www.Flash-eBrochure-Maker.com Pages: . .

| I Foat E] E A B

Please customize the flash template here.

[ElTool Bar Settings H
it Flash Shopping Brochure
The Book Logo |
Logo URL |
Book Title: iure-Maker.com|
Page Number Box On ... False
BlButtons Bar S
ElHome Button =
Home Buton Visble i E B o Py
Page URL =
Open Window self E" -_—- " A =
ElAbout Button = - —
AboutButton Vistle ride
Content
Full Screen Button Show
BlHelp Config
Help n Show
Help Content File
Help Window Width 400
Help Window Height 450
‘Show Help At First Hide
ElPrint Config
Print Enable No
Print Watermark e
[ElDownload setting
DowrosdEnsble o b

href=nhttp:/fuww. fipbuilder.com

Flash Shopping Brochure enables you to make your flipbook in your favorite style.
The custom settings mainly include 4 parts: Template Selection, Tool Bar Settings,
Flash Display Settings, and Flash Control Settings.

1. Template settings:

(1) CIickHicon to enter into template selection interface, choose your

favorite template and theme;

% Select a Template 9=
Choose a flipbook template here. {Double-click to make a quick selection)
B8 (More and more templates will be provided in future.)
Z Get More Themes Online
Classical Template enables you to show your page-flipping eBook in unadorned style, which you can even use to show your eBook.
without the bottom toolbar, so that all of the attention will be focused on your eBook content. OF course, you can insert a proper
background image to deep the impression of your audience too,
| Templates -
Classical ol Bl | el - - -
I v
Float
[iE] spread ' 7777777
Blank Blues Colorful
Dazzle Florid Flow-red
v
l Refresh ‘J [ Remove The Template I [ Remove The Theme ] Remove functions needs Addministrator rights!

Copyright 2010 by Flash-eBrochure-Maker.com
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There are 3 templates for you to choose: Classical, float and spread.

Classical:

Blank

Blues

Colorful

Florid

Flow-red

Blank

Dazzle

Dazzle

Florid

Florid Flow-red
Blank Blues Colorful
e .
! -~

Flow-red

Copyright 2010 by Flash-eBrochure-Maker.com
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(2) Click @ icon to save the template setting for later use;

(3) Click = jcon to import flash template setting;

2. Tool Bar Settings:

Bl Tool Bar Settings
HTitle Bar
[EButtons Bar
Tool Bar on top Falze
HButton Icons

1) Title Bar
ETitle Bar
The Book Logo C:\Wsers\Public\Pict...
Logo URL
Book Title wwwe FlipBuilder.com
| Page Mumber Box ... |False ﬂ

(1) Choose alogo (Image or SWF only) for your flipbook;

(2) Define the logo URL;

(3) Define a title for the flipbook (This value accept HTML format text. For example:
<a href="http://www.FlipBookMaker.com'
target='_blank'>FLIPBOOKMAKER.COM</a> | <font color="#ff0000' size='14'>Red
Color</font>);

(4) Decide to make page number box on bottom or not.

2) Button Bar

| ElButtons Bar
HHome Button
Habout Bukton
HFull Screen

Help Butkan Shio

[HPrint Config
EDownload setting
HZound
FHZoom Config
EHSearch
Hshare
FHAuka Flip
HBookmark
[H3ingle Page
EHLanguage

Copyright 2010 by Flash-eBrochure-Maker.com
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(1) Home Button

|  EHome Button
Home Button Visible Hide
Page URL
Open Window Self

Show/hide home button and set home page URL; decide to open window in self or
blank window.

(2) About Button

| Blabout Button
About Button Visible  |Hide
Conkenk
Show/hide about button and define content such as company file and contact info.
(3) Full Screen Button

Full Screen Button Show

Show/hide full screen button; click m icon to view the flipbook in Full Screen,

click icon n or "Esc" button to exit from the Full Screen.

(4) Help Config

| ElHelp Config
Help Button Show
Help Content File
Help Window Width 400
Help Window Height 450
Showe Help At First Hide

Show/hide help button; choose the help content file (image and SWF only);
define help window width and height; choose to show/hide help at first.
The help content file will show you manual of this software, if you leave it empty,
default help content will show up.

(5) Print Config

—eo——= o=

| BlPrint Config
Print Enable feg
Print Watermark File

Enable/disable printing function; define watermark file (image and SWF only) to

be printed out. Click icon to print out the flipbook.

Copyright 2010 by Flash-eBrochure-Maker.com
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(6) Download Config

| BlDownload setting
Download Enable Mo
Download URL

Enable/disable to download the flipbook; define the download URL. Click

icon to download the flipbook.

(7) Sound Settings

| BlSound
Enable Sound Enable
Sound File
Sound Loops -1

Enable/disable background sound; select background sound from your

computer; set sound loops (set"-1" to play the sound all the time while viewing

the flipbook).

m icon stands for "sound on"; nstands for "sound off".

(8) Zoom Config

| ElZoom Config
Zoom in enable Yes
Scroll with mouse Mo

Enable/disable zoom function: CIickﬂicon to zoom in; cIickﬂ icon to zoom
— IR .
out. In the float template, you can also use to adjust

the page size.
Choose to scroll with mouse or not.

(9) Search Function

ElSearch
Search Button Show
Search Highlight Color | Il 0x403080
Least search charac...|3

Choose to show search button, then you will see the search buttona in the
tool bar (make sure you have checked "Enable Search" option in "Import PDF"

interface); define highlight color and the least search characters; click the search

Copyright 2010 by Flash-eBrochure-Maker.com
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button and you will see the popup search window, type the search words and

click, then you will find the wanted content.

(10)  Share

Elshare
| [ Share Button
Sodal Share Button | Show

@ Share Button:

| BlShare Button |
Share Button Show
Email Subject
Email Body fink}

Choose to show the share button, and then the e-mail share buttonEwiII
show up in the tool bar, your readers can share your flipbook with others via
e-mail if they enter the e-mail link with subject.

€ Social Share:

Social share is very useful to make your flipbook shared. Choose to show social

share, the social share button mwill show up. Your readers can share your
flipbook with their families and friends via Facebook, Twitter, Digg, Yahoo and

other social networks.

Social Share

[f] Facebook 3 Twitter
inl Linkedin Google
B Delicio.us Yahoo
Bl Digg [ stumblelpon

Hz ve i Ak

@j Reddit m Mixx

'O Technorai [+ More

Copy

(11) Auto Play

Copyright 2010 by Flash-eBrochure-Maker.com
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|  EautoFip
Enahle Yes
Flip Interval 3
Play Count 1

Auto flip when startup |Mo

Select "Yes" to enable auto flip mode, click n icon to start auto flip. Define
the flip interval (seconds of staying on each page); then set play count to
define how many times of auto play for the flipbook (-1 stands for continuous
play). Choose "Yes" or "No" to automate auto flip when start up.

(12)  Thumbnail Button

|| Thurnbnail Button Enable |

Enable thumbnail button, click the thumbnail button@to view the page

thumbnail of the flipbook. See below the thumbnail interface:

(13) Single Page

Copyright 2010 by Flash-eBrochure-Maker.com
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Elsingle Page
Enable Single Page Enable
Show Defaulty False |

Enable/disable single page to see the flipbook in sigle page or two spread

pages. Click D icon to view the flipbook in single page; click micon to get
back to the normal two spread pages mode.

(14) Language Settings

| ElLanguage
Language English;Chi. J
Switchable Mo

Click=licon to enter the language selection interface:

- Language Setting

==

You can new or edit a language for the flash fiipping book. The Labled column below is the string that will be displayed in the
flash. The language will be listin the flash template settings.
All the checked language on the left, will be pushed to flash book when publish. The first checked language on the top will be
the default language in flip book. You can point a language to the published fiipping-book by spedify in the address like

w http: /e, XXX, com/mybook. html?pagelndex =4&lang=Japanese

Lauangues
D o [@sem | [ G | [ o]
7] Chinese Language Settings
V| French
. Label Labeled e
Arabic
First Button Premiére page
German L
Next Page Button Page suivante E
Greek Last Button Dernigre page
Hebrew Previous Page Button Page précédente
Italian Donrload Button Telécharger
Japanese Print Button Imprimer
Search Button Recherche
Portugues Clear Search Button Clear
Portuguese Baok Mark Button Marque page
Help Button Aide
Enable FullScreen Button Plein écran
Disable FullScreen Button Fenétre
Sound On Button Son
Sound Off Button Muet i

Define the language for the flipbook, or you can choose two or more
languages and choose "Yes" for language switchable option, then you and

your readers can select the preferred language while reading the flipbook by
clicking the i-__jicon.

o
Click = to create a new language; click *x to remove the selected

.| Edit . .
language; click ‘L/to edit language item.

(15) Tool Bar on top
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| Tool Bar on top False j

In the float template, you can choose "True" for "Tool Bar on top", the tool
bar will show up on the top of the flipbook.

(16) Button Icons

B Button Icons

| Icon Colar J

Click 'ﬂicon to enter the color selection interface, choose color for the icons.

3. Flash Display Settings

|E| Flash Display Settings
Background Alpha |
Retain the book to center  |Yes
EHFont
Initial Show Mone
Show Corner Flip Effect | False
HBackground Config
Flash Window Color B 0454545
Page Background Color CJoxfrFe
HBook Proportions
HBook Margins
HPage Shadow
Hide Book Frame Bar Mo
Right To Left Mo
Hard Cover Mo
Flipping Time 0.6
EHPage Mumber
EMinime Style

1) Background Alpha

| Badkground Alpha ]

Set the value of alpha (0 to 1) to control the transparence of the background in
flip book.

2) Retain the book to center

| Retain the book to center |Yes ]
Set "Yes" to retain the flipbook in the center of the window, if you choose "No",
the flipbook will be on the right side.

3) Font Settings
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EFont
HButtons
HTitle and Windows
HBookmark
HSearch
You can choose font color and font type for the buttons, title and windows,

bookmark and search result panel.
4) Initial Show (Float and Spread templates only)

You can set initial show for bookmark and thumbnail, which will show in the left

panel.

5) Show Corner Flip Effect

|| Show Corner Flip Effect  |True ﬂ|

Set "True" for "Show Corner Flip Effect”, then you will see the flip effect at the

corners.

Flash Shopping Brochure

Publish digital flash shopping brochure with page fl|

6) Background Config

| ElBackground Config
EHBackground Color
EBackground

(1) Background Color
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| ElBackground Color |
Gradient Color A J0xFFFFFF
Gradient Color B CloxFFa0FF
Gradient Angle a0

Define background color with gradient color or pure color (the same color for
"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between
two colors.

(2) Background Image

ElBackground
Duter Background File
| Background position | Scale to fit |
Inner Background File  |D:‘\program...
Background position Scale to fit

Choose background images for outer and inner backgrounds you’re your

computer:

(3) And you can define the image position to fit the window scale:

Scale to fit

Fill

Top Left

Top Center
Top Right
Middle Left
Middle Center
Middle Right

7) Flash Window Color

| Flash Window Color | SToRTRTs] -

Choose color for flash window such as the book window, "Help" window, "Print"
window and so on.
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8) Page Background Color

| Page Background Color =]
When loading pages, or if the page number of your PDF file is odd, the page (the
last page) will show with the "Page Background Color".

9) Book Proportion

| BlBook Proportions
Page Width 540
Page Height 720

You can define width and height for the flipbook.

10) Book Margins

| ElBook Margins
Top Margin 10
Bottom Margin 10
Left Margin &l
Right Margin &l

Set parameter for the book margins such as top margin, bottom margin, left
margin and right margin.

11) Page Shadow

| BlPage Shadow
Left page Shadow a0
Right page Shadow 55

Page Shadow Opadity 1

The value also takes the value of Book Proportions as reference, and the value
interval of "Page Shadow Opacity" is "0~1", the larger value refers to the deeper
shadow color.

12) Hide Book Frame Bar

| Hide Book Frame Bar |Yes ]
If you don’t want to show the book frame bar, choose “Yes” in this option.
13) Right to Left
If the language of your file is read from right to left (such as Arabic), then choose
"Yes" in "Right to Left" option.
14) Hard Cover
If you want your book in hard cover, you can enable "Yes" for hard cover, and you

will see the hard cover effect.
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15) Flipping Time

|| Flipping Time 0.6
Sets page flipping time in seconds according to your needs. (Recommended value
is 0.6)

16) Page Number

| BlPage Mumber

Start Page Mumber (Roman) |0

Start Page Mumber (Arabic) |0
Define the start page number as you like. For example, the first 3 pages are Table
of Content pages with Roman page numbers, and set Arabic page numbers from
page 4, then you will get page number box like below:

[ElPage Number
Start Page Number (Roman) |0
__ StartPage Number (Arabic) |3
Front Cover Page:

|
]

Pages: /8
The Fourth and. Fifth Pages: |
Pages
17) Minime Style
| EMinime style
|Jse Minime Style ‘fes
Width 400
Height 300
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If you don't like the tool bar present in the flipbook, you can choose the Minime

style to hide the tool bar.

4. Flash Control Settings

|EIFIash Control Settings
Security Settings
HLinks
Google Analytics ID

(1) Security Settings

| Security Settings J

If you don't want others to view your flipbook, you can add password to protect

your publication. CIickﬂ to enter into the security config interface.

i Flash Security Config l [éJ

Mote:
Single Password option means that users need the password to view the flash book,

Exclude Front Pages option is to set a page number, all latter pages can't be
viewed without inputting password.

Security Type

@) Mo Security

1
l ANN ]

= Single Password:

Protect Page Range

Add password to retain access authorization. You can define to protect all pages

or set page range.

(2) Links
| BlLinks
Mouse over calor 0300030
Link alpha 0.2
Open Window Blank
Enable after zooming in Enable

If you have check "Import links" option in "Import PDF" interface, or add links
in "Edit Page" interface, then you can define settings here, choose "Mouse over
color", "Link alpha" (refers to the link area opacity, value interval: 0~1, "0"

stands for the area is totally transparent), and "Open Window->Blank/ Self".
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The links also can be clicked after zooming by setting "Enable after Zooming
in->Enable".

(3) Google Analytics ID

ot — o

| Google Analytics ID." | |

In the HTML output format, you can add statistics by using google analytics.

You can get more information about Google Analytics ID from the below site:

http://www.google.com/analytics/ .

» Bookmark Setting

Bookne
eE e ¢ ML X

You can setup bookmarks here

Title P
~|[F] General Intraduction 1
~[[F] Powerful functions 2
=[[F] Custom settings 3

=|[F] Impart zettings 3
Template settings 4

Book style zettings _
If there is bookmark for your flipbook, you can import bookmark directly by

[

=i

clicking ™ icon.

If you don't have an existing bookmark, you can add bookmark manually. Click

e to add titles, and click to add sub-titles, define page number for the
title at the bottom box and apply change.
Title: |Editable Shopping Cart

Page: |2

Input "title text;3" directly in the title to quick
name bookkitle as "title kext" and page as "3"

-

Click “ and ¥ tomove up/down the title. Click r:!‘co export the bookmark.
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> Application Options

Click "Option—> Application Option" to enter the below interface:
&[]

[[] Using Gostscript ta create high qulity images

Ak Needs the free Gostscript to generate high quality images, Please download and install.

Choose to use Ghostscript to create high quality images or not.

» Output Option

After all settings are done, click "Apply Change" to save settings. Then you can

"‘h Convert To Flipping Book
publish the flipbook. Click icon to convert the PDF

to flipbook and the output option interface will show up.

& Output Option '- =

Output |
Output type

:_\;;}’ @ =html © =zp ::?% O *exe ‘ @ ~agp

Also Make Mobile Version  Make output page-flipping eBook works on iPad, iPhene and Andreid mobile devices

@ tiow to make weated eBools avaiable for others onine?

Path |
OutputFolder:  E:\5 fip programs manual\Manuals for Flip Baok Ma
File Name: index html i
Optians !
HTML Tite: 1 [ Advanced

I

[F1Burn to CO
I

0:1:0,F: HL-DT-ST DVDRAM GT34N  ASD0

I

Make it sutomatically play the fipbook in CD

Convert Cancel
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1. HTML
‘;:}/ @ *html

This output type is for uploading created page-flipping eBook onto websites.
You can define HTML Title and other properties by clicking "Advanced" button:

Options

HTML Title: demo % Advanced

Set Keywords, Description or even Script in the below interface:
i)

§§ Advanced Settings

[ HTML Advanced Settings |

HTML Meta Settings
Title: demo
Keywords:  pdf, flipbook, page-fiipping, ebook, online, website, flash, background, music

Description: his page-fipping eBook shows you the stunning flash effect on PDF pages, a

Add Scripts

You can put some tracking
code such as Google
Analytics here,

Need dosed <saipt>tag!

o | | conce

This output type is for compressing the created files into an integral ZIP
package which can be sending out as attachment directly. You can also define
HTML Advanced Settings by clicking "Advanced" icon. Your recipients just need
to uncompress the ZIP file and then they can view the HTML flipbook instantly:

— 3 & demo.html
book.swf

Uncompress

Py - .
O O D

3. EXE

S
oy © “exe
This type is for outputting flipbook as a single executive file, easy storing and

easy viewing:

=27
demo.exe

You can also define Icon and Opening Window Size in Advanced Settings:
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8 Advanced Settings N
Exe Advanced Settings |
Exe Window Info
Caption: demo
Z:m:a Default
o e Optior
Jaximized G S
e Cancel
{
4. APP

If you want to make executable application to run on Mac devices, you can
output as "*.app" format.

5. Mobile Version

| @ Also Make Mobile Version

You can even output Mobile Version while choosing HTML or ZIP format at the
same time.

After creating mobile versions, you just need to output all files online
(including HTML, SWF, "files" and "mobile" folders), then you can visit the
flipbook page through your mobile browser.

6. Burn to CD

V]|Burn to CD

CD Writer ]O: 1:0,G: PLDS DVD-ROM DH-16D55 VD15 v

Disc title: Page-Flipping eBook

V| Make it automatically play the flipbook in CD

After choosing output type, then check the option "Burn to CD", set "CD
Writer", define "Disc title".

> Batch Convert Mode

ok Batch Conwert
Click = to batch convert multiple PDF files to flipbook
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& Batch Convert E |
@) Add PDF Documents I
|
M4a add Files s Add Eolder
Name Path
K
) Settings
Output Settings | POF Setting
Output type
3 o @ =html @; =zip '“é,_ﬂg = exe "_ =.app !
7| Also Make Mobile Version  Make output page-flipping eBook works on iPad, iPhone and Android mobile devices
| path I
Output Folder:  E:\5 flip programs manual\Manuals for Flip Book MakerFlip Book Maker for PDF Manual Browse... | Open
| File Mame: {PDF FileName} > Jhtml I
f
I Options
HTML Tite: My FlipBook - 4 Advanced
Merge All PDF Files to One
<) Convert to Flash
o AddFi
. AL Add Files .
1. Click=% to add two or more PDF files;
. L Add Folder | .
2. Click ‘% to import PDF files from the folder;

3. Choose output format and define output settings as the above mentioned.

» Command Line Mode

Flash Shopping Brochure also provide another conversion mode—Command line
mode, which can automate the conversion, and in this way, you can also publish
an interactive virtual flipbook with impressive page flip effect.

See below the command line mode:

Flash Shopping Brochure Command Line Usage:

PTCMD.exe [Options]

-f<PDF File> The source PDF file.

-o<output folder> Specify the folder for the output files.

-t[html|zip | exe] Output type. Default is html.
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-n<OutputFileName>
-c<caption>

-s<Flash settings>

-r<page range>.

-g<import quality>

-R<GS|SWF|LIB>

engine)

-b<Y|N>

-I<Y|N>

-S<Y|N>

-k<html key words>

-d<html description>

-j<html javascript>

-i<icon file path>

-w<window size>

Examples 1:

Flash Shopping Brochure Utility
User Document

Specify the name for the output file.
Caption for HTML or EXE.

Value format is:<Template name>#[<Theme name> |
<txt_settingfile path>].

<Template name> could be: Classic, Float, Spread.
<Theme name> are list in the "Select a template" window,
such as Blank,Blues,Nostalgia.

<txt_settingfile path> is the file that you export

with "Save the template settings" function

The page range that you want to import from PDF File.
Range value string like:2-15,33,35-36,0r All.(Default: All)

Count be 5,4,3,2,1.5 specify the higher quality larger file
size;1 specifies lower quality smaller file size.(default:4)

Render engine options. (Default: GS, Ghostscript render

Import bookmark yes or no. (Default: Y)

Import links yes or no. (Default: Y).
Enable searchable or not.(Default: Y, enable searchable)
Set the keywords for html output file.
Set the descriptions for html output file.
Set the javascript for html output file.
Specify the icon path for exe output.
Specify the size of exe window.

Value could be: M,F, or some string like:800,600.
(width is 800,height is 600).

PTCMD -f"C:\input.pdf" -0"C:\outputfolder" -n"index" -thtml -c"Title"
-s"Float#c:\my_ebooksetting.txt" -r"1-8,9-14,42" -4 -R"SWF" -bN
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Examples 2:
PTCMD -f"C:\input.pdf" -0"C:\outputfolder" -n"ExeFileName" -texe -i"C:\app.ico"
-c"Title" -s"Float#Blues" -r"All" -q5 -R"GS"

Examples 3:
PTCMD  -f"C:\input.pdf"  -0"C:\outputfolder" -n"index" -tzip -c"Title"
-s"Float#Blank" -r"All" -5 -R"GS" -k"html key words"\

Return Code:

Success

Input file not found

Parameters are invalid

Failed to load PDF

Failed to import bookmarks

Failed to import links

Failed to import searchable information
Failed to save the output file.

i N A
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License Agreements

All copyrights to Flash Shopping Brochure (the Software) are exclusively owned by
Flash-eBrochure-Maker.com. For more information, visit our website at
www.Flash-eBrochure-Maker.com.

Anyone may use this software but all the page-flipping eBooks generated will automatically
have a demo watermark on the first page of them. To remove the limitation you must
register.

Once registered, the user is granted a non-exclusive license to use the Software on one
computer (i.e. a single CPU) at a time. The registered Software may not be rented or leased,
but may be permanently transferred, if the person receiving it agrees to terms of this
license.

The Software unregistered (trial) version may be freely distributed provided the distribution
package is not modified. No person or company may charge a fee for the distribution of the
Software without written permission from the copyright holder.

THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR
IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS,
DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS
SOFTWARE.

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble,
otherwise reverse engineer, or transfer the licensed Software, or any subset of the licensed
Software, except as provided for in this agreement. Any such unauthorized use shall result in
immediate and automatic termination of this license and may result in criminal and/or civil
prosecution.

All rights not expressly granted here are reserved by A-PDF Solution.

Installing and using the Software signifies acceptance of these terms and conditions of the
license.

If you do not agree with the terms of this license you must remove the Software files from
your storage devices and cease to use the product.
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How to Order

Order Online (http://www.Flash-eBrochure-Maker.com/ flash-shopping-brochure/index.html)

How to purchase online?

1. Select a license type above, and click [Buy Now]

2. Select the currency that you want to use. (You can also continue shopping)

3. Fill billing information and select a payment method. (Your information is safe with us)
4. Check the information you filled previously and click "Place Secure Order"

Other Order Ways—W ith Phone/Mail/Fax/Check:

If you are not comfortable ordering online witha credit card, you are welcome to choose an
offline order option in the payment section of the order process. We accept mail, fax, wire,
and PO (if applicable) ordering options in addition to ordering online. We also provide
phone orders through our 24x7 order desk at 1-877-353-7297, or (952) 646-5331 for
International Callers.

Please note that all of the offline ordering options do have additional fees for processing. To
place an order by mail, fax, wire, and PO (when applicable), use the online form and then
choose one of these payment options found in the Payment Method section of the form.
Once submitted online, the appropriate information will be provided to you in your web
browser to send your payment to us offline.

100% unconditional 30 Day Money Back Guarantee

Want to custom the program or have other questions about purchase?
Contact us at support@Flash-eBrochure-Maker.com.
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